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Вступ 
 

Сьогодні в навчальному процесі вищої школи разом із мовами 

програмування, електронними таблицями пропонують 

використовувати такі засоби інформаційних технологій, як 

інтегровані математичні пакети. Їх створення було почате ще в 1980-х 

роках, проте рівня інтерфейсу, що дав змогу ефективно 

використовувати математичні пакети в навчальному процесі, 

досягнуто лише наприкінці двадцятого століття.  

Математичний пакет з погляду педагогіки належить до 

дидактичних засобів навчання, які, за наявності відповідної методики 

викладання, оптимізують навчальний процес. З погляду інформатики 

− це інформаційна технологія, призначена для автоматизації 

розв’язання математичних завдань у різних галузях науки, техніки та 

освіти. Прикладні математичні пакети інтегрують у собі сучасний 

інтерфейс користувача, розв’язання математичних завдань (і 

чисельних, і аналітичних) та засоби візуалізації результатів 

розрахунків. Одна з головних переваг математичних пакетів полягає в 

тому, що вони, звільняючи користувача від рутинних обчислень, 

вивільняють час для обдумування алгоритмів розв’язання завдань і 

способів їх розв’язку, дають можливість подати результати обчислень 

у наочній формі. Універсальні математичні пакети дають змогу 

стандартними програмними засобами легко реалізувати 

найважливіші з методичного погляду принципи: «Від простого до 

складного» та «Максимальна наочність і зручність роботи».  

Програмний продукт Origin − один із найпотужніших засобів гра-

фічного подання результатів. Цей пакет дає змогу не тільки будувати 

різноманітні графіки та оформляти їх відповідно до бажання автора, а 

й проводити математичну обробку результатів: шукати залежності в 

даних, здійснювати інтерполяцію й екстраполяцію та перетворення 

даних безпосередньо в самій програмі. 

Звичайно, в плані графіки та її можливостей цей продукт посту-

патиметься таким програмам, як наприклад, Coral Draw, щодо мате-

матичної обробки він може поступатися таким поширеним пакетам, 

як Mathematika, MathCAD, Maple. Та оскільки основне призначення 

цього програмного продукту − графічне відображення даних, то саме 

з цього погляду за простотою використання й репрезентованими мож-

ливостями Origin має перевагу над зазначеними вище програмами. 
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Дослідники в усьому світі широко застосовують пакет Origin для 

обробки й візуалізації експериментальних даних. Розробником про-

понованої програми є OriginLab Corporation. Повну та демонстраційну 

версії цієї програми можна завантажити на офіційному сайті розроб-

ника: http://www.originlab.com. Демонстраційна версія дає можливість 

ознайомитися із системою, відчути переваги інтерфейсу, зрозуміти 

алгоритм роботи, протестувати функціонал. Ця версія програми 

цілком функціональна, проте існує декілька обмежень: 

 термін використання становить 21 день; 

 усі збережені та роздруковані документи позначено як сформо-

вані в деморежимі, і Ви не зможете використовувати їх для 

подачі в контрольні органи.  

Демоверсію можна використовувати лише для ознайомлення зі 

змістом і можливостями робочої версії програми. Для того щоб пере-

вести програму з демонстраційної версії в робочу, потрібно оплатити 

рахунок й отримати код доступу до програми. 

Запропонований навчально-методичний посібник адресований 

передусім студентам-фізикам. Однак ми сподіваємося, що це видання 

буде корисним і для студентів інших природничих та інженерних 

спеціальностей − усім тим, кому за родом своєї діяльності доводиться 

мати справу з аналізом і візуалізацією експериментальних даних. 

http://me-doc.com.ua/pages/price_new_akcia.php
http://me-doc.com.ua/pages/kod.php
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1. Інтерфейс програми 

Інтерфейс останніх версій Microcal Origin близький до загально-
прийнятих стандартів для Windows: Рядок заголовка − Головне меню − 
Панелі інструментів (рис. 1). 

 
Рис. 1 

У процесі запуску графічного пакета Origin автоматично ство-
рюється новий проект і на робочому полі відкривається вікно робочої 
таблиці Worksheet. Стандартно програма надає їй ім’я Data1. Це ім’я 
може бути змінено за бажанням користувача. Для цього досить ви-
кликати контекстне меню, вибрати функцію Rename і в діалоговому 
вікні замінити стандартне ім’я на бажане. 

Вікно робочої таблиці Worksheet − це одне з доступних робочих 
вікон у проекті Origin, яке призначене для введення даних. Крім 
робочої таблиці, можна створити інші типи вікон: Graph; Layout 
page; Excel workbook; Function; Matrix; Notes. 

Таблиця 1  
Розширення файлів робочих вікон 

Тип вікна Розширення файла 
Project (проект) OPJ 
Graph (вікно візуалізації графіків)  OGG 
Worksheet (вікно даних)  OGW 
Excel (вікно і меню програми Excel)  XLS 
Matrix (вікно створення матриці)  OGM 
Notes (вікно приміток)  ТXT 
Function (вікно побудови графіків заданої функції) OGG 

Робоче поле 

Робоча таблиця 

Провідник Project Explorer 
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Під панеллю головного меню у відкритому вікні Origin є дві 
панелі з набором піктограм швидкого виклику/запуску тієї чи іншої 
команди або опції. Верхня з панелей завжди активна, нижня панель 
стає активною безпосередньо при роботі з графіками. Під час наве-
дення покажчика миші на будь-яку з піктограм з’являється назва 
піктограми, з якої зазвичай стає зрозумілим її призначення. 

Крім того, у режимі роботи з графіками дещо змінюється рядок 
головного меню − при роботі з числовими даними у Worksheet 
(Таблиця даних) у рядку головного меню є вкладки Plot (Побудова 
графіка) і Column (Стовпці), а при роботі з графіками ці вкладки 
замінюються на Graph (Графік) і Data (Дані). 

Усі робочі вікна, створені в проекті, відображаються у вікні 
провідника Project Explorer. У програмі 
можна зберігати як цілий проект, так і окремі 
робочі вікна (розширення файлів робочих 
вікон подано в таблиці 1).  

Для зручності сортування робочих вікон 
можливе створення всередині проекту окре-
мих папок (контекстне меню − New Folder). 

Робочі вікна можуть бути активними і в 
цьому разі відображатися на робочому полі, 
або прихованими й відображатися тільки в 
провіднику. Для приховування робочого вік-
на в Project Explorer на піктограмі потрібного 
вікна слід викликати контекстне меню і ви-
брати функцію Hide (Show − відображення). 
 
 

2. Уведення даних 
 

Для побудови графіка нам знадобляться числові дані. Ввести дані 
можна кількома способами. Найпростіший спосіб − уведення даних 
вручну, заповнюючи відповідні комірки в таблиці. Для цього в 
таблиці Worksheet досить установити курсор на потрібній комірці й 
клацнути лівою кнопкою миші (далі ЛКМ). Комірка буде виділена 
сірим кольором, а в правій частині комірки − встановлено мерехтли-
вий курсор. Після цього можна починати введення даних за допо-
могою клавіатури. 

Уводячи дані, слід пам’ятати про два моменти. По-перше, якщо 
після введення даних у комірку не натиснути клавіші Enter (Введення) 

Рис. 2 
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або не здійснити перехід до іншої комірки таблиці даних (стрілками 
або натисканням лівої кнопки миші), дані з такої комірки не сприйма-
тимуться Origin при побудові графіка. Більше того, після побудови 
графіка вони зникнуть з таблиці даних. Відповідно, це стосується і 
тих випадків, коли потрібно відредагувати дані в уже наявній таблиці − 
зміни будуть сприйняті тільки після натискання клавіші Enter 
(Введення) або переходу в іншу комірку. 

По-друге, слід бути уважним під час уведення нецілих числових 
даних. У нашій країні традиційно прийнято відокремлювати цілі й 
дробові частини чисел комами, тоді як у більшості західних країн 
(зокрема, у США, країнах ЄС) їх відділяють крапкою, а коми 
використовують для полегшення сприйняття розрядів числа, напри-
клад, 1,234,567.89 − це 1234567,89 у звичному для нас розумінні. 
Стандартно Origin використовує як розділовий знак той формат, який 
встановлено при настроюванні операційної системи. Тому, вводячи 
числові дані, насамперед слід переконатися, що вони сприймаються 
правильно. 

У разі потреби тип розділового знака можна змінити. Зробити це 
можна, або змінивши настройки операційної системи, або зайшовши 
в пункт меню Tools (Інструменти), рядок Options (Параметри) на 
вкладці Numeric Format (Числовий формат) і вибравши параметр 
Separators (Роздільник) (див. рис. 3). 

 

Рис. 3 

У разі введення дуже великих і дуже малих чисел можна вико-
ристовувати так званий науковий формат даних, тобто записувати 
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число у вигляді: 1230000 = 1.23е6 або 0.00123 = 1.23е-3. Також слід 
урахувати, що число з дуже великою кількістю значущих цифр після 
коми (байдуже, в якому форматі − звичайному чи науковому) буде 
округлено відповідно до заданої в настройках програми точністю. 
Стандартно це п’ять цифр після коми, однак таку настройку можна 
змінити в тому ж самому пункті меню Tools (Інструменти), рядок 
Options (Параметри) на вкладці Numeric Format (Числовий формат), 
задавши потрібне значення параметра Number of Decimal Digits. 

Уведення значень вручну при сучасних обсягах даних трапля-

ється вкрай рідко. Зазвичай використовують стандартні для сімейства 

ОС Windows команди копіювання і вставляння або здійснюють імпорт 

потрібних даних із файла. 

Винятком є можливість відкриття файла Excel як таблиці з дани-

ми Worksheet (здійснюється стандартно через меню File → Open 

Excel). При відкритті можна вибрати, в якому вигляді будуть до-

ступні дані: як дані в таблиці Origin, або відкриті як лист Excel 

всередині програми Origin, що дає змогу проводити деякі обчислення 

(недоступні в Origin), використовуючи можливості табличного про-

цесора Excel. 

Потрібні дані можна ввести за 

допомогою команди Import у меню 

File (рис. 4). Тип імпортованого 

файла можна вибрати у вкладці, що 

випадає (підтримується велика кіль-

кість типів файлів, у тому числі 

можливий і імпорт із баз даних), але 

зазвичай інформація у файлах міс-

титься в ASCII-форматі, тобто у ви-

гляді звичайних чисел, букв. Стан-

дартними форматами ASCII-файлів 

Origin уважає .dat, .txt, .csv, однак, 

вибираючи довільний тип (*. *), 

можна відкрити будь-який файл. 

Слід звернути увагу, що імпорт 

даних відбувається в активну табли-

цю, при цьому попередні дані губляться. Тому в разі імпортування 

нових даних, якщо є потреба зберегти старі, слід створити нову таб-

лицю даних через меню File → New → Worksheet, або вибравши від-

повідну піктограму. 

Рис. 4 
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У разі імпортування файлів у діалоговому вікні, де потрібно 

вказати шлях до файла, є вкладка Options, у якій можна задати пара-
метри перетворення даних (рис. 5). Це може виявитися необхідним, 

якщо дані всередині імпортова-
ного файла не містять розділо-
вих знаків або розділові знаки 
(delimiter) − незвичайні. Origin 
легко розпізнає такі розділові 
знаки, як пробіл (Space), кома 
(Comma), символ табуляції (Tab). 
З іншими розділовими знаками 
можуть виникнути складнощі. 
Якщо розділових знаків немає, 
то за допомогою перемикача 
Fixed, col widths можна задати 
фіксовану ширину кожного 
стовпця. До цієї вкладки можна 

дістатися прямо з меню: File → Import → ASCII Options. 

Настройку імпорту файлів зберігатимуться до тих пір, доки не 

будуть проведені нові зміни або до закриття файла. Після повторного 

відкриття файла настройки, якщо вони не були збережені в шаблонах, 

будуть автоматично змінені на стандартні. 

 

 

3. Робота зі стовпцями 
 

Стандартно Origin створює вікно Worksheet із двома стовпцями 

А і В. Щоб додати стовпець у вибране вікно, слід зробити його 

активним, у головному меню вибрати функцію Column→Add New 

Columns. У діалоговому вікні, що відкрилося, слід указати, скільки 

стовпців потрібно додати у Worksheet. Додати стовпець можна і 

через контекстне меню (клацання правою кнопкою мишки по білій 

частині робочого вікна Worksheet), вибравши пункт Add New 

Column. Кожному новому стовпцю присвоюється літера латинського 

алфавіту (А, B, C, ... X, Y, Z, AA, BB, CC ...). 

Стандартно перший стовпець відповідає осі OX, а кожний на-

ступний − осі OY. Ця властивість стовпців, так само, як і їхні імена, 

може бути змінена. Для цього потрібно виділити стовпець і, 

викликавши контекстне меню, вибрати пункт Properties. 

Рис. 5 
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Рис. 6 

Значення аргументу або функції даних у стовпці визначається за 
допомогою випадного списку Plot Designation.  

Для створення або зміни даних у стовпці за відомими математич-
ними формулами слід виділити потрібний діапазон комірок і відкрити 
діалогове вікно Set Column Values (головне меню: Column → Set 
Column Values або, викликавши контекстне меню, вибрати Set 
Column Values). 

 
Рис. 7 

Перехід до попереднього стовпця Перехід до наступного стовпця 

Ім’я стовпця Якщо встановити 

прапорець, то імена 

стовпців будуть 

мати вигляд А1, 

А2, .... 

Позначення для 

графіка 

Відображає 

тип даних у 

стовпці 

Формат даних 

у стовпці 

Застосувати до всіх 

стовпців справа 

Застосувати до всіх 
Ширина 

колонки 

Підпис до стовпця 

Поле для 

введення 

функції 

Вибір 

і введення 

функції 

Область 

комірок 

у стовпці 

Вибір 

стовпця 

Опис 

функції 
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У цьому випадку в колонці С у комірках від 1 до 15 з’являться 
результат віднімання значень колонки В із колонки А. 

Математичні оператори: 

Оператор Функція Приклад 
+ Додавання С = А + В 
- Віднімання С = А - В 
* Множення С = А * В 
/ Ділення С = А / В 
^ Піднесення до степеня С = А ^ В 

Якщо у виразі немає дужок, то порядок операцій такий: 
1) піднесення до степеня; 
2) множення і ділення; 
3) додавання і віднімання. 

 
 

4. Побудова графіків 
 

Доступ до основних ін-
струментів для побудови графі-
ків здійснюється через вкладку 
Plot головного меню. Кількість 
стандартних варіантів побудови 
різноманітна (рис. 8), але, крім 
цього, є ще бібліотека шабло-
нів, доступ до якої здійснюєть-
ся за допомогою опції Template 
(Шаблони) в цьому меню. 

Найчастіше використову-
ють відображення результатів 
першими трьома способами по-
будови графіків: Plot – Line 
(відображається лінія між екс-
периментальними точками), 
Scatter (відображаються лише 
експериментальні точки), Line 
+ Symbol (відображаються екс-

периментальні точки і проводиться лінія по них). Тому саме ці 
варіанти розглядатимуть як приклад. Розглянемо випадок, коли 
активною є робоча таблиця. Для побудови графіка слід у головному 
меню вибрати потрібну команду (Plot – Line, Scatter, Line + Symbol). 

Рис. 8 
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У діалоговому вікні, що з’явилося (Select columns for plotting), 
слід вибрати потрібну робочу таблицю з даними, потім указати 
стовпець, значення якого будуть відкладатися по осі Х, аналогічно по 
осі Y, і натиснути клавішу ОК. На екрані з’явиться «дочірнє» вікно 
Graph, із зображенням побудованого графіка. 

 
Рис. 9 

Для того щоб змінити властивості лінії графіка, потрібно викли-
кати діалогове вікно Plot Details (головне меню Format → Plot або 
подвійним клацанням лівою кнопкою миші прямо на лінії графіка). 

 

З’єднання Закладка – Лінія 

(властивості лінії графіка) 

Закладка – Символ 

(властивості точок на лінії) 

Тип лінії 

Крок 1. Вибрати 
з випадного 
списку потрібну 
таблицю 

Крок 2. Вибрати 

стовпець, зна-

чення якого 

будуть відклада-

тися по осі ОХ, 

і натиснути 

кнопку <->X. 

Аналогічно по Y 

Крок 3. 
Натиснути 
кнопку ОК 

Рис. 10 
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На закладці Line існує можливість змінити тип лінії Connect, 

вибрати стиль лінії Style (різні комбінації штрихів і крапок), товщину 

лінії Width, а також колір лінії Color графіка. Прапорець Fill Area 

Under Curve (зафарбовувати ділянку під кривою) дає можливість 

залити ділянку під кривою певним кольором. 

Випадний список Connect містить такі варіанти з’єднання точок: 

• No Line (немає лінії) – точки не будуть з’єднані; 

• Straight (пряма) – точки на графіку будуть з’єднані прямими 

лініями; 

• 2 Point segment (двоточковий відрізок) – задані точки з’єд-

нуються попарно відрізками; 

• 3 Point segment (триточковий відрізок) – графік розбивається 

на ділянки по три точки; 

• B-spline (апроксимація з урахуванням розкиду) – по точках 

проводиться апроксимальна лінія з урахуванням розкиду; 

• Spline (апроксимація) – по точках проводиться лінія, яка їх 

апроксимує, без урахування розкиду; 

• Step horz (крок по горизонталі), Step vert (крок по вертикалі), 

Step center (крок по центру) – точки з’єднуються ступінчас-

тими лініями; 

• Bezier (крива Безьє) – по точках проводиться лінія, яка їх 

апроксимує, з використанням алгоритму Безьє. 

Для перегляду змін досить клацнути на кнопці Apply, щоб поба-

чити результат проведених дій без закриття діалогового вікна. Якщо 

отриманий результат не задовольняє, можна продовжити роботу в 

діалоговому вікні до отримання потрібного виду графіка, після чого 

клацнути на кнопці ОК. 

 

 

5. Побудова графіка функції, 

заданої аналітично 
 

Для побудови графіка функції, заданої аналітично, потрібно в 

головному меню вибрати File − New і в діалоговому вікні вибрати 

пункт Function (Функція). Відкриється вікно Plot Details, що дає 

змогу визначити вид відображуваної функції. Це діалогове вікно міс-

тить дві закладки. 
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Рис. 11 

Закладка Function: у полі F1(x) = визначається вид функції. 
Вбудовані математичні функції можна добавляти за допомогою ви-
падного списку поряд із кнопками Add (добавити) та Undo (скасу-
вати). Якість графіка (кількість точок, які беруть участь у побудові) 
визначається опцією Density (густина). 

Закладка Line визначає вид графіка функції. 
Після визначення виду функції в полі F1 (x) = і натискання 

кнопки OK з’явиться робоче вікно Function. На сірому полі робочого 
вікна розміщуються кнопки: 

New Function… − до-
давання графіка нової 
функції в це робоче вікно; 

Rename – зміна імені 
функції; 

Polar – зміна системи 
координат (із декартової 
на полярну); 

Rescale – зміна мас-
штабу (відразу ж після 
створення графіка мас-
штаб може бути визначе-
ний неправильно, тому 
слід натиснути цю клаві-
шу, і графік автоматично 

перемасштабуєтся − мінімальне і максимальне значення по осі Y 
відповідатиме найбільшому й найменшому значенню на заданому 
інтервалі). 

Рис. 12 
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6. Побудова найпростіших 3D-графіків 
 

Крім побудови графіків і залежностей між двома параметрами, у 
програмному пакеті Origin передбачена можливість побудови зобра-
ження тривимірних об’єктів. 

Як приклад, наведемо побудову зображення піраміди, заданої 
координатами своїх вершин: А1, А2, А3, А4. 

Для задання координат вершин потрібні будуть три стовпці в 
новому вікні даних (Worksheet), причому один зі стовпців повинен 
мати мітку (Z). Для відображення тільки вершин піраміди достатньо 
лише чотирьох рядків у таблиці, а для промальовування ребер 
піраміди доведеться продублювати координати вершин у зміненому 
порядку: А1, А3, А2, А4 (див. рис. 12). При побудові піраміди з про-
мальовуванням ребер спочатку потрібно виділити колонку з міткою Z, 
а потім вибрати на вкладці Plot команду 3D XYZ → 3D Trajectory 
(див. рис. 13). 

           
Рис. 13 

У результаті отримаємо зо-

браження об’єкта (див. рис. 14). 

З побудованим малюнком 

можна проробити всі ті ж дії з 

оформлення: зміна розмірів 

шкали по будь-якій з осей, змі-

на заголовків осей, відображен-

ня сітки і т. п., як це робилося у 

процесі побудови графіка. 

Також слід зазначити, що 

після побудови 3D-об’єкта з’яв-
Рис. 14 
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ляється додаткова панель інструментів (стандартно вона розміщува-

тиметься угорі, під основними панелями інструментів − див. рис. 14), 

що дає змогу повертати, нахиляти, збільшувати або зменшувати це 

зображення. Використання такого інструменту дає можливість роз-

глянути об’єкт у різних проекціях. 
 

 

7. Задання параметрів сторінки 
 

В Origin графічні вікна створюються на основі наявних шабло-

нів. Розмір сторінки, орієнтація встановлюються відповідно до 

властивостей, указаних у шаблоні. Внести зміни можна через головне 

меню File → Page Setup або будь-яким способом відкрити діалогове 

вікно Plots Details і перейти до кореня деревоподібної схеми зліва 

(Function1, Graph тощо). 

 

Рис. 15 

Print/Dimensions (друк/розмірність) 

У групі Dimensions (розмірність) задається ширина і висота 

сторінки (Width, Height). Якщо встановлено прапорець set to printer 

dimension when opened from a template (встановити для принтера роз-

мірність із шаблону), то настройки для нового проекту будуть узяті з 

настройок друку (File-Print). 

Miscellaneous (різне) 

У групі Performance (подання) можна за допомогою випадного 

списку View Mode (режим перегляду) вибрати спосіб відображення 

сторінки на екрані: 
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Print view (для принтера) − відображення відповідно до установок 

принтера; 

Page view (для сторінки) − відображення відповідно до пара-

метрів сторінки; 

Window view (у вікні) − малюнок відображається в усьому вікні; 

Draft view (чернетка) − чорновий режим відображення. 

 

 

8. Оформлення атрибутів графіка 
 

Вид графіка, що його стандартно створює програма Origin, на-

вряд чи задовольнить вимоги до оформлення малюнків. Тому для 

надання йому належного вигляду (із зазначенням підписів до шкал, 

створенням додаткових осей та сіток і т. п.) використовується відпо-

відне діалогове вікно. Виклик цього вікна здійснюється подвійним 

натисканням ЛКМ на одній з осей, що обмежують графік, або шкал із 

числовими підписами (рис. 16). Це вікно містить декілька вкладок, 

кожна з яких відповідає за оформлення того чи іншого елемента. 

 

Рис. 16 

Scale 

закладка шкали координат. Ця закладка використо-

вується для встановлення вертикальної або горизон-

тальної осі, встановлення шкали від початкового 

до кінцевого значення з певним кроком, типу шкали 

(лінійний, логарифмічний, логічний і т. д.). 
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Title&Format 
закладка заголовка і форматування. Встановлює тип, 

ширину, стиль позначення осі координат. 

Grid Lines 

закладка координатної сітки. Установлення горизон-

тальних і вертикальних додаткових та основних осей, 

кольору й типу основних та додаткових осей. 

Break 

закладка установки вертикальних і горизонтальних 

розривів. Слід використовувати, коли експеримен-

тальні значення одне від одного значно відрізняються 

(на кілька порядків). 

Tick Labels 
закладка міток на осях. У цій закладці встановлюють

ся колір міток, їх положення, формат, розмір і т. д. 

Minor Tick 

Labels 

другорядні мітки осей. Додаткові можливості щодо 

оформлення міток, пов’язані з їх додаванням. 

Custom Tick 

Labels 

звичні мітки осей. Поворот у назвах осей, додавання 

міток на осях вручну самим користувачем, центру-

вання написів і т. д. 

На закладці Scale (шкала) у списку Selection (виділення) можна 

вибрати, для якої осі − горизонтальної (Horizontal OX) або вертикаль-

ної (Vertical OY) − встановлюватиметься розмір відображуваної шка-

ли. У полі From задається початкове значення, а в полі To − кінцеве 

значення шкали, а також крок Increment, з яким на цій шкалі відобра-

жатимуться числові значення. Кількість проміжних поділок задається 

в Minor Ticks. У випадному списку Type (Tick Labels) (тип) можна 

вибрати тип масштабування по осі. 

У закладці Title&Format (заголовок і формат) можна задати 

заголовок осі, його розташування, колір і формат штрихів. 

У списку Selection вибирають потрібну вісь. Установлений пра-

порець Show Axis&Ticks відображає вісь і штрихування. Колір осі 

вибирають у випадному списку Color, товщину − у списку Thickness, 

довжину основних штрихів на осі − у списку Major Tick. Особливо 

слід звернути увагу на нижню частину вкладки Apply To (застосува-

ти до): обрану схему відображення елементів графіка можна поши-

рити на окремий шар на цьому графіку або на всі графіки, відкриті в 

цьому проекті. Це дає змогу оформити всі графіки, які можуть 

знадобитися під час написання роботи, в одному стилі, не затрачаючи 

зайвого часу на оформлення кожного графіка окремо. 
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Рис. 17 

Також є можливість створення заголовка для кожної осі в полі 

Title. Формат цього заголовка задається в іншому діалоговому вікні 

Text Control (виклик цього діалогового вікна через головне меню 

Format → Axis Titles → X Axis Title). 

У закладці Grid Lines (Лінії сітки) форматується координатна 

сітка. Так само, як і в інших закладках, у списку Selection вибира-

ється вертикальна або горизонтальна вісь. Прапорці в полях Major 

Grids (головна сітка) і Minor Grids (допоміжна сітка) визначають, які 

лінії сітки будуть видимі. 

 

Рис. 18 
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У списках Line Color і Line Type визначають колір та тип ліній і 

для основної, і для додаткової сіток. У полі Thickness задають 

товщину ліній сітки. Група Additional Lines (додаткові лінії) дає 

змогу відобразити на графіку лінію на протилежному краї від осі 

(прапорець Opposite) і лінію, що проходить через нульову точку на 

осі (прапорець Y = 0 і X = 0). 

Вкладка Break дає змогу ввімкнути режим відображення розриву − 

прапорець Show Break (показати розрив). Після цього всі елементи 

вкладки стають активними, і можна вказати діапазон розриву та деякі 

параметри відображення даних. Використання цієї опції доцільне, 

якщо функція суттєво різниться в різних областях і ці області відда-

лені одна від одної.  

 

Рис. 19 

У списку Selection виберіть, для якої осі потрібно встановити 

розрив. У групі Break Region (область розриву) вкажіть, від якого 

(From) до якого (To) значення осі проходитиме розрив. У групі 

Break Position (положення розриву) в полі % of Axis Length (% від 

довжини осі) можна задати місце розташування символа розриву. У 

групі Scale Increment (крок шкали) у полях Before Break (перед 

розривом) і After Break (після розриву) можна вказати крок основ-

ного штрихування на осі, відповідно до і після розриву. 

За допомогою наступних трьох вкладок можна оформити підписи 

до поділок шкали.  
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Рис. 20 

Підписи можна задавати для кожної із чотирьох осей графіка 
(вкладка Tick Labels), можна змінити їх розмір, використовуваний 
шрифт, кут повороту підписів. З іншого списку опцій слід згадати 
можливість використання елементів Prefix і Suffix. Число або символ, 
додані в поля, будуть відображатися, відповідно, перед і після під-
писів до поділок. 

Подвійне клацання на легенді графіка відкриває вікно властивос-
тей легенди (Text Control), де можна змінити границі, заливку, шрифт, 
розмір, колір і текст легенди. Тег у полі легенди \ L (1) відображаєть-
ся у вигляді символа, відповідного першій лінії графіка, а тег % (1) − 
у вигляді підпису відповідної колонки листа даних. 

 
Рис. 21 



 23 

Текст форматується в спеціальному форматі, і те, як він буде 

виглядати на сторінці, відображається в мемо-полі внизу вікна. 

Background (фон) дає можливість задати фоновий колір підпису. 

Rotate (поворот) задає кут повороту всього напису в градусах. 

Встановлення прапорця Center Multi Line (рядки по центру) дає 

змогу вирівняти текст по центру. 

Важливо! Якщо російський/український текст відображається 

неправильно, потрібно виділити написане й вибрати кириличний 

шрифт (Arial Cyr, Times New Roman Cyr та ін.). 

Слід зазначити, що введений надпис завжди можна виправити, 

викликавши діалогове вікно введення тексту подвійним клацанням 

миші на вибраному надписі. Розміщення надпису можна змінити за 

допомогою миші та видалити, якщо цей напис уже не потрібен. 

 

 

9. Робота з даними на графіку 
 

Після побудови графіка може виникнути потреба уточнити будь-

які дані з їх відповідним виправленням та отримати нові значення для 

подальшого використання. Для цього можна скористатися стандарт-

ними інструментами Origin, які розташовані у вигляді піктограм під 

рядком головного меню. Точне розташування піктограм на панелі 

меню залежить від настройок і версії програми. Тому при описі 

даватиметься назва опції, якій відповідає піктограма. 

Збільшити або зменшити малюнок, який відображається, можна 

за допомогою опцій Zoom In і Zoom Out . Розгорнути малюнок 

на всю сторінку можна за допомогою опції Whole Page . Якщо є 

потреба більш детально розглянути конкретну ділянку малюнка, то 

зручніше скористатися інструментом Enlarger (Збільшення) . 

Після вибору цієї піктограми слід натиснути ліву кнопку миші і, не 

відпускаючи її, виділити потрібну ділянку на графіку. Повернення до 

вихідного масштабу малюнка здійснюється подвійним кліком на тій 

же піктограмі. 

Ще два інструменти − Screen Reader і Data Reader −  

призначені для зняття даних із графіка. Інструмент Screen Reader дає 

значення координат х і у тієї точки, на якій він міститься. Інструмент 

Data Reader призначений для визначення координат конкретної 
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точки з числа тих точок, які були використані при побудові графіка. В 

обох випадках при використанні цих інструментів з’являється додат-

кове вікно Data Display, в якому записані координати. При цьому у 

разі використання Data Reader додатково наявна інформація про 

розміщення вихідних даних. 

Якщо положення будь-якої точки на графіку різко відрізняється 

від інших, то інформація, отримана за допомогою цих інструментів, 

може знадобитися для перевірки або виправлення вихідних даних. 

Наступний інструмент Data Selector  використовується для 

вибору діапазону з усієї області даних, представлених на графіку. Це 

може стати в пригоді, коли, наприклад, обчислюють визначений 

інтеграл у заданому діапазоні або шукають аналітичну залежність 

серед даних у заданому діапазоні, не розглядаючи всі інші точки. Для 

використання цього інструменту слід, після натискання піктограми, 

пересуваючи покажчик миші, вибрати потрібний діапазон даних. 

Інструмент Draw Data  призначений для нанесення на графік 

даних вручну. З нанесеними на графік даними можна працювати, як 

із даними з таблиці, більш того, можливі навіть математичні операції 

між цими групами даних. Після нанесення додаткових точок на 

графіку у відкритому проекті Origin створюється таблиця, в якій 

зберігаються результати нанесення точок. У разі потреби ця таблиця 

може бути активована для подальшої роботи. 

Наступний інструмент − Text Tool  − призначений для ство-

рення написів та коментарів. Причому цей інструмент, як і наступні 

п’ять, може бути використаний для роботи і з графіками, і з 

таблицями даних. 

Наступні п’ять піктограм  призначені для виклику 

інструментів малювання стрілок, ліній, деяких геометричних фігур.  

 

 

10. Настроювання властивостей шару 
 

Графічний проект в Origin має таку ієрархічну схему: графік роз-

міщується в координатних осях, вони, у свою чергу, є частиною шару 

або кадру, і, нарешті, кілька кадрів або шарів утворюють сторінку. 

Якщо в діалоговому вікні Plots Details (двічі натиснути ЛКМ на 

графіку) зліва виділити Layer1 (шар 1), то справа з’явиться три 

закладки Background, Size/Speed, Display (рис. 22). 
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Рис. 22 

Закладка Background (фон) визначає колір фону (Color) і вид 

рамки навколо кадру (Border Style). 

Закладка Size/Speed (розмір/плавність) визначає розмір шару і 

положення на сторінці: Height – висота, Width – ширина графіка, Left, 

Top – відступ від верхнього лівого кута у вибраних одиницях виміру 

(Unit − одиниця виміру). 

Закладка Display (відображення) дає змогу вмикати та вимикати 

відображення осей, підписів до осей, легенди і даних. 

 

 

11. Додавання шару на сторінку 

 

Часто потрібно додати ще один шар (або де-

кілька) на сторінку. Наприклад, для відображення 

окремого фрагмента графіка в іншому масштабі, 

щоб краще було видно особливості поведінки функ-

ції на окремій ділянці. Вставити новий шар із точно 

таким же графіком можна через головне меню: 

Tools → Layer (Інструменти → Шар). У вікні Layer 

потрібно клацнути на правій крайній кнопці. 

Решта кнопок дає змогу створити новий шар без даних. Щоб 

додати в новий шар дані для їх графічного відображення, можна 

зробити подвійне клацання на іконці шару, і у вікні, що з’явилося, 

вибрати потрібний набір даних і кнопкою => додати ці дані в шар. 

Рис. 23 
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Новий шар без даних можна створити, використавши меню Edit → 

New Layer. Після цього у правому верхньому куті з’явиться цифра 2, 

що означає шар номер 2. Активний шар виділяється чорним, неактив-

ний − білим. Додавання даних у новий шар здійснюється так само, як 

і в описаному вище випадку. 

 

 

12. Розміщення графіків 
 

12.1. Склеювання графіків 
 

У програмному продукті Origin передбачена можливість відобра-

ження декількох графіків на одному аркуші. Для цього можна засто-

совувати інструменти, що дають змогу розміщувати графіки в різних 

місцях сторінки, використовувати різні шари для відображення даних. 

Найпростіший спосіб розміщення декількох графіків на одному 

малюнку полягає у використанні опції Merge all Graph Windows у 

пункті меню Edit або вибір піктограми  в рядку меню. 

Ця команда буде застосована до всіх графіків 

цього проекту, які не перебувають у згорнутому 

(Minimize) стані. При цьому користувачеві буде 

поставлено питання, чи слід зберегти вихідні 

графіки. Оскільки ця процедура незворотна, ре-

комендується вихідні графіки зберігати. 

При використанні процедури «склеювання 

графіків» з’явиться діалогове вікно, в якому 

можна вказати, як саме потрібно розмістити 

графіки на аркуші. 

Кількість стовпців і 

рядків можна 

вказати вручну. Якщо графіків для 

заповнення всіх «осередків» не ви-

стачить, Origin залишить ці області по-

рожніми, зобразивши тільки координат-

ні осі. Після вказування кількості стовп-

ців і рядків з’явиться діалогове меню, в 

якому можна вказати розміри відступів 

від краю сторінки для відображуваних 

графіків та величини відступів між 

Рис. 24 

Рис. 25 
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самими графіками. 

Результат «склеювання» на прикладі чотирьох графіків пред-

ставлено на рисунку 26. З кожним із графіків можна працювати 

окремо: змінювати стиль оформлення, робити підписи і т. д. 

 
Рис. 26 

Кожен із графіків на об’єднаному аркуші розміщується у своєму 

шарі (Layer). Доступ до настроювань відображення відповідного 

шару здійснюється подвійним кліком на номері шару в лівому верх-

ньому куті аркуша → Layer Properties. Тут можна змінити розміри 

шару та деякі параметри його відображення, якщо в цьому є потреба. 

При виборі пункту Plot Associations (наприклад, за допомогою 

подвійного кліка на номері відповідного рівня) користувач отримує 

можливість додати дані на обраний графік. Отже, із шаром можна 

проводити ту ж роботу, що й з окремими графіками. 

Процедура «склеювання» графіків може бути корисна в разі 

відображення декількох однотипних графіків на одному малюнку.  

 
12.2. Зміщення графіків 
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Якщо дані знято при однакових умовах експерименту і шкали в 

них збігаються, то, побудувавши всі ці графіки, використовуючи на-

вички відображення даних на одному й тому ж рисунку, можна отри-

мати зображення, на якому всі графіки будуть майже накладатися 

один на одного. І навіть використовуючи різні кольори, нелегко зро-

зуміти, що до чого належить (рис. 27). Тому зручно було б спектри 

змістити. 

 
Рис. 27 

У пакеті Origin для цього є спеціальна функція Waterfall (водо-

спад). Виділивши всі колонки таблиці, на панелі інструментів у меню 

Plot (графік) виберіть пункт Special Line / Symbol (спеціальні лінії / 

символи). У випадному списку знайдіть функцію Waterfall (водоспад) 

(рис. 28), якщо клацнути на ній, усі спектри, які раніше були накладе-

ні один на одного, автоматично зміщуються по осях X та Y (рис. 29). 
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Рис. 28      Рис. 29 

Оскільки шкали спектрів збігаються, то логічно було б змістити 
графіки лише по осі Y. У функції Waterfall (водоспад) є деякі опції, 

які під час зміщення графіків автоматично 
відкриваються у вигляді вузької панелі Wa-
terfall Options у верхній частині малюнка. Це 
такі опції: Offset Amount (величина зсуву), 
Reverse Order (зворотний порядок), Fill Area 
(заливка). Для зміщення графіків тільки по 
осі Y слід скористатися опцією Offset Amount 
(величина зсуву). Після натискання на цю 

кнопку з’явиться вікно (рис. 30), у цьому вікні у списку XY offset 
(зміщення по XY) слід вибрати стан Enable (допустимий) у списку 
Total Y offset (%) (зміщення по осі Y у %), встановити значення, відпо-
відне майбутньому зміщенню графіків, а в списку Total X offset (%) 
(зміщення по осі X у %) задати значення 0. Після чого потрібно 
натиснути OK. 

У результаті графік набуде такого вигляду (рис. 31). 

Рис. 30 
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Рис. 31 

12.3. Суміщення графіків 
 

За допомогою функції суміщення графіків на одному рисунку є 
можливість відобразити криві з різними масштабами. Розглянемо цю 
опцію на прикладі суміщення двох спектрів для різних поляризацій та 
спектра плівки. Відомо, що інтенсивність спектра плівки набагато 
менша, тому для відображення графіків на одній площині скориста-
ємося вбудованим у пакет Origin шаблоном Double-Y (суміщення 
графіків). Для цього слід переконатися, що в таблиці стовпці A, B, C, 
D мають ролі X, Y, Y, Y відповідно. Далі виділити всі стовпці 
таблиці. На виділеній ділянці потрібно викликати контекстне меню 
(рис. 32), у ньому в меню Plot (графік) вибрати пункт Special Line / 
Symbol (спеціальні лінії / символи) і у випадному списку − шаблон 
Double-Y (суміщення графіків). 

У результаті цих дій має відобразитися графік (рис. 32).  
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Рис. 32 

Пакет Origin автоматично підбирає шкалу для інтенсивності 
спектра плівки. Всі координатні осі мають починатися з нуля. Зовніш-
ній вигляд графіків і підписи осей редагують відомим вам способом. 

Для того щоб було більш зрозуміло, до чого належить той чи 
інший графік, до малюнка додається текстовий коментар (ПКМ → 
Add Text (додати текст)).  

 
 

13. Робота зі спектрами 
 

13.1. Віднімання фону 
Розглянемо деякі можливі операції зі спектрами. 

Для того щоб зі спектра відняти лінійний фон, слід 

скористатися меню Tools (інструменти), вибрати 

пункт Baseline (базова лінія) (рис. 33). У цьому вікні 

на закладці Baseline у полі Create Baseline (ство-

рити базову лінію) у рядку User Defined Equation 

(рівняння, яке визначає користувач) задайте значен-

ня фону, що буде відніматися. Після цього створіть 

цю базову лінію, натиснувши на кнопку User 

Defined Equation. На графіку відобразиться ця сама 

лінія (рис. 34). 
Рис. 33 
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Рис. 34 

Щоб відняти зі спектра вказаний фон, потрібно натиснути кнопку 

Subtract (відняти), на рисунку відобразиться результат віднімання. 

Для того щоб відняти лінійний похилий фон із вихідного спектра, 

потрібно в рядку User Defined Equation задати значення функції. 

Наприклад, якщо ввести функцію 2900 – 4*Χ, то після натискання на 

кнопку Create Baseline базова лінія та результат віднімання будуть 

виглядати таким чином (рис. 35−36). 

Аналогічно можна віднімати нелінійний фон, задавши рівняння 

фону. 

    

Рис. 35     Рис. 36 

При відніманні фону змінюється не лише графік, а й вихідна 

таблиця даних!  
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Відняти лінійний фон зі спектра можна й іншим способом, ско-
риставшись меню Analysis / Subtract / Straight Line (аналіз / відні-
мання / пряма лінія). Після вибору цієї опції курсор набуває вигляду 
хрестика, за допомогою якого задається початок і кінець прямої лінії. 
Натиснути клавішу Enter. Лінія з’явиться на дуже короткий промі-
жок часу, й автоматично відобразиться результат віднімання ліній-
ного фону (рис. 37−38). 

 

Рис. 37      Рис. 38 

Крім віднімання фону, зі спектрами можна проводити інші 
операції (+, -, *, /, ^). Для цього потрібно зобразити графіки на одному 
рисунку (в різних шарах), використовуючи меню Analysis / Subtract / 
Reference Data (аналіз / віднімання / посилання на дані). При цьому 
з’являється діалогове вікно Math on / between Data Set (математичні 
дії з наборами даних) (рис. 39), у якому в списку Available Data 
(доступні дані) потрібно вибрати й перемістити бажані набори даних 
у поля Y1 та Y2, використовуючи кнопку = >. У віконці operator 
(операція) вказують необхідну математичну дію з представлених у 
списку. Після натискання на кнопку OK на графіку відобразиться 
результат віднімання та графік, що віднімається (рис. 40−41). 

 

Рис. 39 
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Рис. 40     Рис. 41 

 
13.2. Згладжування спектрів 

 

За допомогою програми Origin можна провести згладжування 

спектрів, тобто усунення шуму. Для цього слід скористатися на па-

нелі інструментів меню Analysis (аналіз) і у випадному списку 

вибрати Smoothing / FFT Filter (згладжування / фільтрація Фур’є). 

При цьому з’являється вікно Smoo-

thing (рис. 42), у списку якого Enter 

Number of Points (введіть кількість то-

чок) пакет Origin типово передбачає 

число точок − 5. Визначити оптимальну 

кількість точок для згладжування можна 

лише дослідним способом. Якщо графік 

виходить занадто «кошлатим», то кількість точок потрібно збільши-

ти. Якщо на графіку зникають деякі важливі деталі, то кількість точок 

слід зменшити. У списку Smoothed Line Color (колір згладжувальної 

лінії) виберіть колір кривої, натисніть Apply (застосувати) і OK. 

Згладжування можна провести й іншим способом: у меню 

Analysis / Smoothing (аналіз / згладжування) скористайтеся функцією 

Adjacent Averaging (усереднення по декількох точках). З’явиться 

таке ж вікно, як і при використанні FFT Filter (фільтрація Фур’є). 

Виконавши необхідні дії, ви отримаєте результат, схожий на 

результат використання фільтрації Фур’є. Відмінність полягає в тому, 

що в легенді відображається та опція, яку ви використовували для 

згладжування: для фільтрації Фур’є − абревіатура FFT, для 

усереднення по декількох суміжних точках − AA (рис. 43). 

Рис. 42 
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Рис. 43 

 

13.3. Апроксимація спектрів лоренціанами 
 

Для апроксимації спектрів лоренціанами в меню Analysis (аналіз) 

виберіть пункт Fit Multi – Piaks / Lorenzial (апроксимація функції з 

декількома максимумами / лоренціан). На екрані з’явиться вікно, в 

якому в списку Number of Peaks вказати кількість піків і підтвердити 

це натисканням кнопки ОК (рис. 44). 

У змінному вікні в списку Initial half width estimate (початкова 

оцінка напівширини) стандартно буде запропоновано значення 

напівширини кривої, яке потрібно також підтвердити натисканням 

кнопки OK (рис. 45). Потім курсором у вигляді хрестика відзначити 

всі піки на спектрі. Фіксація положення максимуму відбувається при 

натисканні на клавішу Enter. Після пророблених операцій на моні-

торі з’явиться апроксимувальна лінія та шість лоренціанів, які вико-

ристовувалися для підгонки спектра (рис. 46). У протоколі результа-

тів Results Log будуть записані всі значення параметрів піків. Ці 

параметри мають такий зміст: area − площа, center – положення мак-

симуму, width – ширина, height – висота. 

          

Рис. 44    Рис. 45 
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Рис. 46 

13.4. Розкладання графіка на криві Гауса 
 

Однією з необхідних 

математичних операцій мо-

же бути розкладання графі-

ка на криві Гауса. Для цьо-

го потрібно, зробивши ак-

тивним вікно Graph, виб-

рати в меню Analysis → Fit 

Multi-Peaks → Gaussian. 

З’явиться діалогове вікно 

Number of Peaks, у якому 

слід указати кількість піків, 

для яких буде зроблено роз-

кладання. Курсор, що з’я-

вився, встановлюють яко-

мога точніше на одному з піків і фіксують подвійним клацанням 

миші, в результаті чого з’являється вертикальна лінія, яка позначає 

положення першого піку. Аналогічну процедуру проводять над дру-

гим піком. 

Рис. 47 
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Результатом проведених дій є таблиця Results Log. 

 
Рис. 48 

 

 

14. Вставляння графіків з Origin у документи 

Word або PowerPoint 
 

Для вставляння створеного графіка в документи Word або 

PowerPont слід передусім зробити активним потрібний графік, а потім 

у меню Edit вибрати Copy Page і можна вставляти графік у документ.  

Якщо після вставляння графіка потрібно внести до нього зміни, 

то досить двічі клікнути мишкою по графіку просто в документі Word. 

Якщо на комп’ютері встановлена програма Origin, то вона буде 

викликана автоматично, і графік можна буде редагувати прямо в 

документі. 
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Лабораторна робота № 1 
Ознайомлення з графічним математичним 

пакетом Microcal Origin. Візуалізація 
експериментальних даних 

Практичні завдання 

Завдання 1. Заповнити робочу таблицю. Вставити ще один стов-
пець, додати підписи до стовпців і змінити їхню ширину. 

 
Завдання 2. Обчислити опір (R = U / I). 

Завдання 3. Побудувати графік R(U). 

Завдання 4. Змінити властивості графіка R(U). 

 
Властивості лінії графіка: з’єднана лінія – апроксимувальна без 

урахування розкиду; тип лінії − суцільна; колір лінії − червоний; 
товщина лінії − 3; точки − червоні кола. 

Масштаб: по осі ОХ – від 0 до 32 з кроком 2; по осі ОУ – від 0 до 
1000 із кроком 200. 
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Координатна сітка: товщина осей – 2; штриховка – всередину; 
головна координатна сітка сірого кольору, товщина 0,5; наявність 
додаткових ліній, протилежних осям. 

Підписи: вісь ОХ – «U, V»; вісь OY – «R, Om». 
Легенда графіка: змінити легенду графіка. 

Завдання 5. Створити робочу таблицю даних і побудувати гра-
фіки функцій F1(k) і F2(k). 

k 
2 ke

a
k


  F = cos(a) F = sin(a) 

Від 0,001 до 0,035 
із кроком 0,002 

   

Завдання 6. Створити звіт із лабораторної роботи № 1 у програмі 
Microsoft Word. 

План звіту 
2. Тема. 
3. Мета. 
4. Завдання № (формулювання завдання та отриманий графік). 

 
 

Лабораторна робота № 2 
Графічний математичний пакет Microcal Origin 

Практичні завдання 

Завдання 1. Побудувати графік функції 
2( )( ) sin( ).a x bF x A e x      

Нехай А = 103, а = 10-2, b = 1, ω = 0,5. 

Завдання 2. Змінити властивості графіка згідно з рисунком. 

 



 40 

1) Змінити властивості легенди графіка: у вікні Text Control 

замість % (1) ввести F(x) = A exp(-a(x - b)2) + sin(ωx); математичні 

функції виділити жирним, змінну x – курсивом. 

2) Змінити підписи до осей. 

3) Змінити властивості координатної сітки згідно з рисунком. 

4) Створити пояснювальний надпис A = 103, a = 10 - 2, ω = 0,5, b = 1. 

5) Змінити масштаб по осі X: від -100 до 100. 

6) Натиснути Rescale. 

7) Додати дві нові функції 
2( )( ) sin( ),a x bF x A e x      де b = 40 

і b = -40 відповідно. 

Завдання 3. Змінити властивості шару: задати колір для фону 

графіка (сірий) і рамку з тінню. Змінити розміри графіка. 

Завдання 4. Створити новий шар, у якому відобразити ділянку 

графіка від 80 до 100 по осі Х. Змінити необхідні параметри шару 

(розмір, положення), властивості графіка. За допомогою панелі малю-

вання виділити збільшену ділянку на першому графіку (див. рис. 

нижче). 
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Завдання 5. Побудувати в новому робочому вікні графік функції 
2( )( ) sin( ),a x bF x A e x      де А = 103, а = 10-2, b = 1, ω = 0,5. 

Задати необхідні параметри, щоб графік функції відображався таким 

чином: 

 

Завдання 6. Створити звіт із лабораторної роботи № 2 в програмі 

Microsoft Word. 

План звіту 

2. Тема. 

3. Мета. 

4. Завдання № (формулювання завдання й отриманий графік). 

 

 

Лабораторна робота № 3 

Візуалізація даних фізичних експериментів 

за допомогою пакета Origin. Складні графіки. 

Накладання шарів 

Практичні завдання 

Завдання 1. Створити тип вікна: Excel Workbook з уведеними 

даними (дод. 1). 

Завдання 2. Обчислити провідність σ. Побудувати графіки за-

лежності σ(λ) при різних температурах. 
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Завдання 3. Відобразити чотири графіки на одному аркуші. Змі-

нити властивості графіків: 

1) змінити підписи до осей: вісь ОХ – «σ, Om-1»; вісь OY – «λ, nm»; 

2) створити пояснювальний надпис відповідних температур. 

 

Завдання 4. Побудувати графіки в новому робочому вікні на 

одній сторінці при Т = 140, 160, 180 К. Змістити графіки по осі Y. 

Змінити підписи до осей відповідно до завдання 3.  

Завдання 5. Побудувати графіки при Т = 80 К та Т = 160 К на 

одному рисунку з різними масштабами, додати текстовий коментар, 

змінити колір ліній графіків – червоний та синій.  
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Завдання 6. Створити звіт із лабораторної роботи № 3 у програмі 

Microsoft Word. 

План звіту 

2. Тема. 

3. Мета. 

4. Завдання № (формулювання завдання та отриманий графік). 

 

 

Лабораторна робота № 4 
Аналіз експериментальних результатів  

Практичні завдання 

Завдання 1. Імпортувати дані з файла (дод. 2). Побудувати графік 

спектра для досліджуваного зразка № 1 (OX – довжина хвилі λ, nm; 

OY – інтенсивність світла I, abs.unit).  
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Завдання 2. Із графіка спектра відняти лінійний фон. Вирізати 

область 1475–1625 нм.  

 
Завдання 3. Побудувати графік спектра для досліджуваного 

зразка № 2 (OX – довжина хвилі λ, nm; OY – інтенсивність світла I, 

abs.unit).  

1) Розмістити графіки на один аркуш і виконати дію додавання 

графіків.  

 
2) Провести згладжування спектрів, кількість точок для згладжу-

вання − 15.  
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Завдання 4. Виконати апроксимацію спектрів лоренціанами.  

 

Завдання 5. Розкласти графіки на криві Гауса. 

 

Завдання 6. Створити звіт із лабораторної роботи № 4 у програмі 

Microsoft Word. 

План звіту 

2. Тема. 

3. Мета. 

4. Завдання № (формулювання завдання та отриманий графік). 
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